# ScalableLearning

## Getting Started and Instructions Manual

Version 3.21, December 2016.

### Getting Started

- Accessing ScalableLearning
- Creating an Account
- Logging In

### Creating a new Course

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Adding a Video to a Course

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Adding Interactive Quizzes to a Video

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Formatting Text, Images, Links, and Equations

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Adding Notes or Annotations to Videos

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Previewing as a Student

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Creating In-class Peer Instruction Quizzes

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Creating Distance Peer Instruction Questions

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### Adding Students

- Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.

### About the Main Menu

- Dashboard
- My Courses
- Account
- Help

### About the Course Menu

- Edit Mode
- Review Mode
- In-class Mode

### Reviewing Student Online Progress

- Reviewing Quiz Performance
- Responding to Student Questions and Discussions
- Responding to Surveys and Making Results Visible to All Students
- Display Options for Review
- Class Progress
- Detailed Lecture Statistics

### Using ScalableLearning In-Class

- Reviewing Students' Online Performance
- Choosing In-class Material
- Using ScalableLearning In-Class
- Peer Instruction with ScalableLearning
- Reviewing Student Performance After Class

### Viewing your Courses

- Organizing Courses with Modules
- Adding Links to a Course
- Course Links

### Adding Teachers and TAs

- Sharing Courses with Other Teachers

### Recording Videos

- Setting Up the Screen
- Recording
- Trimming

### Uploading Videos to YouTube

- YouTube Videos Privacy: Unlisted or Public

### More Information

You can read more about Flipped Classroom teaching and tips and tricks in the Introduction to Flipped Classroom Teaching available in the Help menu on ScalableLearning.
Getting Started

Accessing ScalableLearning

1. **Browser:** We strongly encourage the use of Google’s Chrome browser ([www.google.com/chrome](http://www.google.com/chrome)). Newer versions of Safari and FireFox generally work as well. Older versions of Internet Explorer will not work. On the iPad you should use Safari.

2. **Site:** Go to [www.scalable-learning.com](http://www.scalable-learning.com).

Creating an Account

1. You can log into ScalableLearning either with your School/University account or by creating a separate ScalableLearning account. (Use the separate ScalableLearning Account if your School/University is not listed.)

2. When you first login you will be asked to fill in your account information.

   a. You should choose an “Online Name.” The Online Name is what your students see when you respond to their questions. You can use your full name or something like “David (Teacher)”. By default it is set to a random string to keep users anonymous.

   b. If you login with your School/University account you can only change the name/email/school through your university account page.

   c. If you login with a separate ScalableLearning account you need to provide this information and you will receive an email with a link to confirm your account before you can log in. If you do not receive the email within a few minutes, check your spam/junk mail folder.

3. You will next be shown an introductory video. Click on the appropriate link to see the video for students or teachers. (You can always re-watch the video from the Help menu later.)

   Welcome to ScalableLearning!

   New to ScalableLearning? Please watch a short introductory video to help you get started.

4. After watching the introductory video, you have successfully created an account and logged in and are ready to start using ScalableLearning.
Logging In

1. Click on “Login” and either use your School/University account or enter your email address and password.

   a. If you use your School/University account, you can only change your account password through your School/University account page.

   b. If you use a ScalableLearning account, you can choose “Keep me logged in” to avoid having to log in each time and use the “Reset password” link to reset your ScalableLearning account password.
Creating a new Course

1. Choose “Create a new course” from the “My Courses” menu.

2. Fill in the course information fields:

   a. The “Short Name” is typically the course code, such as CS101.
   b. You can provide a “Course Image URL” so students are shown a picture for the course when they log in. Simply find the image online and right-click and choose “Copy URL” and paste it in here.
   c. You should set the course start and send dates and timezone for deadlines.
   d. You can choose to disable course registration after a certain date by enabling “Disable Registration After.”
   e. Note that all of these options can be changed later in the Course Information page.

3. [Optional] To Copy an Existing Course: Choose the course from which you want to copy course content in the “Copy Data from Existing Course” menu. To copy data from a course you need to be registered as a teacher or a TA for that course.

4. Click “Create Course”.

5. After you create a course you will be brought to the **Edit Mode**. This will typically be empty unless you have chosen to copy data from another course.

   a. The Course Content list on the left is empty for a new course. Here is where you will see content you add with the “Add Content” and “Add Module” buttons.
   b. To add content (videos, quizzes, surveys) click “Add Content”.
   c. To create a module to organize your content, click “Add Module”.

---

© 2016 David Black-Schaffer/ScalableLearning
Modes

1. ScalableLearning has three modes for interacting with your course, which can be accessed by clicking on the mode buttons at the top:

   a. **Edit Mode**: Allows you to create and modify interactive online content, including videos, quizzes, adjust due dates, etc.
   
   b. **Review Mode**: Allows you to review how students have done online, see the results of interactive quizzes, answer online questions, and choose material for the in-class review.
   
   c. **In-class Mode**: Allows you to project the material you selected for review and use in-class voting for peer instructions. It is designed to be used with a projector in the classroom.

2. **Administration** includes functions for editing course information, adding other teachers/TAs, viewing the student list, adding students, and posting announcements.
Adding a Video to a Course

1. Go to the Edit Mode by clicking on Edit at the top.

   ![Edit Mode Interface]

   Go to the Edit Mode by clicking on Edit at the top.

2. Click "Add Content" to add new content to your course.
   a. You can organize content into Modules by clicking Add Module.

3. Choose the type of video to add:

   Add New Content:

   a. Video: Online interactive videos for students to watch at home.
   b. In-class Video: material for you to use in the classroom with students.
   c. Distance Peer-Videos: material for students to use remotely in groups in distance courses.
   d. Note: You can change the type of video later in the Details pane.
4. Enter the Title and URL for the video in the Details list on the right. Click the green check button to save your entries:

a. For YouTube videos, click on the "Share" link below the video and then copy the https:// link.

b. Paste the URL into the Video link field in the Details.

c. Note: for videos from a server at your institution, contact your local IT support staff for how to access them.
5. You will now be asked if you would like to trim the video. By trimming a video you can choose the start and stop time to only display part of a video.

   Would you like to trim your video?

   With trimming, you can choose the start and stop times to show only a portion of the video to students. To change the trim times you have to re-add the video.

   Use Full Video  Trim Video

   a. If you choose to trim the video, you can use the handles on the left and right of the video to select the start and stop times.

   Video Editor: Recursion

   ![Video Editor Interface]

   Start time: 00:00:20
   End time: 00:02:25

   Use the handles above to trim video

6. You will now see your video in your course:

   ![Video in Course]

   6. You will now see your video in your course:

7. You can hide the Details menu by clicking on the blue “Details” header it to make the video larger when adding questions. (You can also hide the Course Contents list by
8. Note that if you did not have a Module selected before you clicked Add Content then one was created for you. In this case the video was placed inside a Module called “New Module” in the Course Content list on the left. You can edit the Module's name by clicking on it and editing it under “Details” on the right.
**Video Settings: In-order, Required, Appearance, Due Dates, and Video Type.**
You can specify the settings for a video under Details by clicking on “Settings”.

- **Video Type**: This allows you to select whether the video should be used as an online video for student preparation (Video), an in-class video (In-class Video) or for remote students doing online peer instruction (Distance-peer Video). Choose the type that reflects how you want students to interact with the video.

- **In-order**: If checked, students cannot skip ahead to other videos in a module until they have completed all the previous videos.

- **Required**: The students must complete this video to get credit for the module. If a video is not required, then it will be marked as “optional” for the students.

- **Appearance Date**: When a video is visible to the students. By default this will be the Module's Appearance Date so that all items in a Module appear at the same time.

- **Due Date**: When a video is due for the students to not be marked as late. By default this will be the Module's Due Date so that all items in a Module are due at the same time.
Adding Interactive Quizzes to a Video

1. Go to a video by choosing the course from the “Courses” menu and then clicking on the Module and video in the Course Content list on the left:

2. You can hide the blue Details list (right side) and the green Content list (left side) by clicking on them. This will make the video larger and easier to work with.
3. To add a quiz, play the video to the point where you want to insert the quiz (or click in the timeline to go to that point.)

4. Click on “Add Video Quiz Here” when you get to the time where you want to add the quiz.

5. Choose the type of quiz you want to insert:

   - **On-video Quizzes**: These are placed on top of the video and should be used if you have placed the quiz options in the video, or you want the students to interact with the graphical content in the video. You can choose:

   - **Text Quiz**: These quizzes cover the video with a white background and present the quiz as a series of text choices. Use this type of quiz if you have a video where the questions are not recorded in the video and you want to insert them.

   - **In-video Survey**: These options are the same as the In-Video Quizzes, but they are surveys, so there is no right answer.

   - **In-video Quizzes and Surveys**: Students click on different places in the video to answer the question.
e. **Types of quizzes:**
   i. **One answer:** Only one of the multiple choice answers is correct
   ii. **Multiple answers:** Any number of the multiple choice answers may be correct
   iii. **Drag and Drop:** Students move answers to the correct destination.
   iv. **Free text answer:** You can have students enter free text responses, which can be optionally matched to a correct answer.

6. Enter the Quiz Question below the quiz. This is the text shown when you review the results graph. You will see the quiz listed on the right in the Quizzes list under Details.

   a. You can specify if the quiz is required or optional by checking the “Required” box.
   b. You can have the quiz question displayed over the video by checking the “Display question over video” box. This is useful if you want students to interact with the video but the question text is not in the video, for example, if you are using a video someone else produced.
7. Double click on the video to place each answer:

**Video Editor: Recursion**

- A. When you place an answer you should enter the Answer text as this is what is displayed with the results graphs.
- B. You should also be sure to enter an Explanation. This is what students see when they choose this answer and is particularly important for incorrect answers so students can learn from their choices.
- C. If this is the correct Answer, then choose “Correct Answer”. The choice on the video will turn green to indicate it is a correct answer.
- D. You can move the choices around by dragging them.
- E. You can delete an answer by clicking on the Delete button and then confirming the deletion.
- F. When you are finished with the quiz, click “Done”.

8. **In-Video Drag-and-Drop**: Students move items around over the video to the right location.

- A. Enter the Quiz Question below the quiz. This is the text shown when you review the results graph.
b. Double-click to create a new answer.

c. Drag the “Start” to where you want the item to start when the students first get to the quiz.

d. Drag the answer number (in this case 0) to the correct final location. You can resize the final location by dragging the corner of the answer.

e. Edit the item by clicking on the default text and putting in the name of the item students will drag. Here the item will be called “1st Recursion”.
i. You should provide an explanation of why this answer is correct.
ii. You can delete the item by clicking the X and then confirming the deletion.

f. Continue creating other answers to drag and drop by double clicking.

9. **Text Quiz**: Students choose from text-based answers.
   a. Enter the Quiz Question below the quiz. This is the text shown when you review the results graph.

   ![Example: Searching for a File](image)

   b. Enter the Answer choice and Explanation, and click the “Correct” box if it is a correct answer.
c. Use the “Add Answer” button to add additional answers.

d. You can delete an answer by clicking on the X and then confirming the deletion.

e. When you are finished, click “Done”.

10. You can see all the quizzes in a video by clicking “Show All Quizzes” or choosing “Quizzes” in the “Details” list on the right.

a. You can go to any quiz by clicking on it and edit the quiz.

b. You can delete a quiz by clicking on the Trash Can next to the quiz.

c. You can move a quiz to a different time by editing it and changing its time.
**Formatting Text, Images, Links, and Equations**

ScalableLearning supports the use of stylized text anywhere you can edit text. You can change the size, color, and style of the text you type, as well as inserting links, images, and mathematical equations.

To modify the style of text simply double-click on the word you wish to change:

You can set the color by clicking on the paint bucket icon:

To insert a mathematical equation, type it in LaTeX format between two $ and click on the Equation symbol to turn on equations:

Becomes:

You can insert images by pasting in the URL of the image, selecting it, and then clicking the image icon.
1. Paste in the URL to the image:

   ![Uppsala University Logo]

2. Select the URL:

   ![URL Selection]

3. Click the image icon, and the image will be displayed:

   ![Uppsala University Logo Displayed]
Adding Notes or Annotations to Videos

You can add notes to videos to indicate chapters or slides and provide annotations that show over the video to add information or corrections. Notes show up in the video player timeline and in the student’s video timeline, and can be used to navigate through the video, both when watching it and in-class. You can also provide annotations for notes, which will appear over the video when the student gets to that point in the video. Annotations are particularly useful if you want to clarify or correct something in the video. The annotations can even include links to other material.

Notes can have Titles and/or Annotations:

- Notes with a Title show up in the student’s Time Line and can be used to navigate the video in-class. You can use these to indicate sections in the video.
- Notes with an Annotation show the annotation over the video when the students play them and can be used to navigate the video in-class. These can be used to provide additional information, such as links, or corrections to the material in the video.
- Notes with neither a Title nor an Annotation show up as markers. These can be used for navigating the video in-class. E.g., if you place one at each point in the video you want to go through, you can then use the video much like a slide presentation in class by walking through the notes.

1. To add a note, play to the time where you want a note and click the “Add Note” button or press “n”. You can then give the note a Title (which will appear in the students’ timeline and the in-class mode for easier navigation) and/or an Annotation (which will appear over the video when the students play it).

2. You can view/edit markers in the video details pane on the right and click to edit or delete them.
### Previewing as a Student

To preview as a student, click the orange “Preview as Student” at the bottom of the Course Content menu.

- You can click on the quizzes in the Timeline on the right to go directly to a quiz question and try them as a student.
- When you are done, click “Exit Student Preview” at the top to return.
Creating In-class Peer Instruction Quizzes

In-class Peer Instruction content is created in the same way as online video quizzes: upload a video and add quizzes. However, in-class quizzes have more details to enable the four steps of Peer Instruction: Introduction (teacher introduces the problem), Self (students answer and vote individually), Group (students discuss and vote together), and Discussion (the teacher leads a class discussion). As a teacher you place the quiz in the video, define markers for any slide animations in the video, and set the beginning and end times of the in-class question. When you advance to the question in-class, ScalableLearning will enable student voting at the question and display the results when you advance to the Discussion.

To see how this works, consider this timeline of a video. The Start of a Peer instruction quiz is placed where the quiz first appears in the video and the Quiz itself at the point where the question appears. The End is placed when the explanation for the quiz is finished. Markers can be placed in the quiz to separate different slides or animations for in-class display.

These times are shown in ScalableLearning in the video:

1. To create in-class Peer Instruction content first add an In-Class video to your module by clicking “Add Content” and choosing “In-class Video”. In-class videos are shown in the Course Contents list marked with a icon:

```
Recursion 01:00
In-class Practice Problems 01:00
Online Preparation Video 01:00
```

2. To display the video in-class as a presentation you will probably want to insert Notes at each transition. (E.g., new slide or animation.) This allows you to use the keyboard or a presentation remote to move between parts of the presentation as you would with slides. To do so, play to the time where you want a note and click the “Add Note” button. You can then give the note a Title (which will appear in the students’ timeline and the in-class mode for easier navigation) and/or an Annotation (which will appear
over the video when the students play it).

3. You can view/edit notes in the video details pane on the right.

4. Then play to the point where the in-class quiz options are displayed, and click “Add Video Quiz Here”.

Video Editor: Profiling OpenCL
5. You can then choose the type of quiz you wish to insert:

![Quiz options](image)

6. Enter the quiz question (which will appear on screen and on students' phones) and insert the quiz options by double-clicking on the screen where you want each option to appear, and configuring them as you would for an online quiz. You can specify that a quiz has a start and end time (used to know where to start the in-class quiz as you go through the material) and provide timers for use in-class to help keep you on track. The timers will be displayed as count down timers while the question is visible in-class.

![Quiz question](image)

7. The Start and End times of the quiz are displayed in the timeline and can be changed by dragging them. These times determine how much of the video (and any markers during this time) are displayed in-class during the Peer Instruction voting. The Introduction will start at the Start Time, the Self and Group student votes are at the quiz time, and the Discussion goes until the End Time.

![Timeline](image)

8. During the in-class session, you will see the four steps of the Peer Instruction displayed during the question: Introduction (teacher introduces the problem), Self (students answer and vote individually), Group (students discuss and vote together), and Discussion (the teacher leads a class discussion).

![Peer Instruction steps](image)

Circles shown in-class indicate markers during these portions so the teacher knows
how many slides are present. During the Discussion the results of before and after voting (blue/green) are shown on-screen.

What do we expect?
Creating Distance Peer Instruction Questions

ScalableLearning supports distance peer instruction as well as in-class. Distance Peer Instruction videos are created in the same was as in-class Peer Instruction videos, but students are expected to complete them at home. When a student starts a distance peer instruction video he or she is asked to choose another student in the class to work with. The two students are then directed to watch the video, answer the questions individually, and then in a group. This process simulates having the students do the peer instruction in-class. We recommend that you have the students use Skype or a similar program such that they can talk with each other while they are doing the peer instruction together.
Adding Students
To add students to a course they need to register and join the course with a course Enrollment Key.

1. Go to the course by choosing it from the “My Courses” menu.
2. From the “Administration” menu choose “Add Students”.
3. Copy the text provided for student registration, and email it out to your class using your institution’s email list.

```
Dear Student,

This term in Demo we will be using ScalableLearning to help make your learning more interactive. To get started go to https://test.scalable-learning.com/#/courses/enrollId=6534a22612 and login with your school email.

Sincerely,
David Black-Schaffer
```

4. Students will then register by creating an account on ScalableLearning and adding the course using the Enrollment Key in the email.

Student List
You can see a list of enrolled students by choosing “Student List” from the “Administration” menu. Here you can see a list of all enrolled students, send emails to students, remove students from the course, and export a student list.
About the Main Menu

Dashboard

- Shows a calendar view of the course due dates and a list of course announcements

A FEW SECONDS AGO

Hi All,
There was a lecture missing from the caches lecture. I just added it, so please make sure you’re caught up.

Cheers,
-David

--- Introduction to Computer Science

My Courses

- Choose a current course to go directly to it
- Create a new course: create a new course as a teacher or a new copy of an old course
- Join a new course: join a course as a student with a course enrollment code.
- Show all courses: show all courses for which you are a TA or Teacher, including old courses.

Account

- Account Information: Change your account information including your name, email, and password, and delete your account.

Help

- Access help for using the system, including Getting Started tutorials and the Instruction Manual.
• Direct access to the ScalableLearning Teacher Forum.
• Privacy policy
• **Feedback:** Provide feedback about ScalableLearning, including reporting problems with the system or suggestions for improvements. (We take every report very seriously, so please do let us know how we can improve!)
About the Course Menu

The course menu lets you choose to **Edit** a course content, **Review** student progress, and present material **In-class**. The course menu also gives you access to **Administrative** functions such as viewing a class list, adding students and teachers, and sending announcements.

When you click on **Edit**, **Review**, or **In-Class** you will see instructions:

**Edit Mode**

**Course Editor**
Choose a module to the left view and edit its contents. Drag modules around to re-order them.

- **Add Module**
- **Add Content**
- **Preview As Student**

Right-click on an item to Copy, Paste, or Share it with other teachers.

**Review Mode**

**Review Module**
View and respond to students’ quizzes and questions, and choose material for in-class.

- **Module Review**
- **Module Quiz**
- **Module Completion**

**Review Course**
View which students have completed each module on-time or late.

- **Course Completion**
- **Course Graph**

**In-class Mode**

**Display In-class Content**
Choose a module to display selected materials In-class.
Reviewing Student Online Progress

Before each class meeting you will want to review how students did on the online quizzes and what questions they had about the material. While you are reviewing their progress, you should also select which parts of the online material you would like to bring into the classroom for an in-class review.

1. Go to the course by choosing it from the “Courses” menu.
2. Click on Review to switch to Review Mode
3. Choose the Module to review from the Course Content list on the left.
4. The Progress review has four parts:
   a. **Lecture Preview**: Shows you the location in the video lecture where the quiz or question occurred. This is useful for reviewing the context of the quiz or question. To make the preview larger just press the space bar on your keyboard.
   b. **In-class Review Time Estimate**: Estimates how much time it will take you to review the material you have selected for in-class review. It is important to make sure you don’t spend too much time reviewing the online material in-class since you want to focus in-class time on active learning.
   c. **Module Progress Timeline**: Shows you all the quizzes and student discussions in time order (top is earlier, bottom is later) for the whole module.
   d. **Keyboard Shortcuts**: Lists shortcuts you can use to make it faster to review your students’ progress and respond to their questions.
5. Tip: You can close the Course Content list on the left by clicking on the green title to make more space for reviewing the student progress.

6. The first part of the Progress Timeline shows you how many students have completed the Module:

   a. You can click on “Show Student Details” to see how much each student has completed in this module.

7. The second part shows you, for each module, how students did on each quiz and questions they asked and where they clicked the Confused button. You can scroll down to go through all quizzes and questions in the whole Module.

**Reviewing Quiz Performance.**

1. Here is an example from the Module “Logic gates to truth tables,” which is 3:26 long and has 1 Quiz.

   a. There was one quiz (at time 1:26) and you can see how students answered. The green answer is the correct one.
3. Clicking on the quiz will show you the lecture in the video preview.

4. Pressing the space bar on the keyboard will temporarily enlarge the video preview so you can see it in more detail.

5. Pressing the space bar again will shrink the video preview.
6. You can choose to make a quiz part of the in-class review by clicking the “Show in class” button next to it or typing “M” on the keyboard when it is selected. Items selected for in-class review are marked with a yellow background.

7. When you mark an item for in-class review, the Time Estimate is updated to tell you how long much in-class time your review will take. Here the time estimate is 3 minutes because one quiz has been selected for review.
8. To go on to the next item either click on it, or press the down-arrow on the keyboard.

Responding to Student Questions and Discussions
1. Students can ask questions and have discussions while watching the video. When such a discussion is selected, the video preview goes to the place in the video where the student asked the question and you can press the space bar to enlarge the video.
a. You can see next to the question how many students voted for this question to be reviewed in-class, how many flagged it as inappropriate, and you can reply to the question by typing “R” or pressing “Reply” and mark it for in-class review by clicking “Show in class” or typing “M” for mark.

2. You can reply to students and answer their questions by clicking on “Reply” or typing “R”.

   a. When you post your reply the student will receive an email with your answer, and they can see the reply in their video timeline.
   b. If the student’s question was public, then other students can see your reply as well.
   c. You can delete your reply by clicking “Delete”, but an email is still sent when you post the reply.

Responding to Surveys and Making Results Visible to All Students
Anonymous surveys can be included in your Modules. The results are shown and you can reply to students comments (without knowing who the student is) by clicking “Reply”. You can also choose survey responses for in-class review by choosing “Show in class.”
Surveys also allow you to see which responses came from the same student by clicking “Related”. You can make the survey results visible to the whole class by clicking “Make Survey Visible to Students” at the top of the survey.

Display Options for Review
You can choose which items from the online lecture to display in the Progress Review from the Settings menu and format the output for printing or saving to a PDF:

Class Progress
To see overall class progress, click on the Review mode and choose “View Module Completion”.

Review Module Completion
Choose a module to review the students’ online progress, respond to questions, and select material for in-class review.

View which students have completed each module on-time or late.
You can manually change a student’s progress by clicking on a lecture and choosing a different status.

**Detailed Lecture Statistics**

You can get more detailed lecture statistics by clicking on “Show Student Details” at the top of the Lecture Review. Under the Lecture Statistics tab you can see a timeline of where students paused, asked questions, reviewed, and clicked confused.

Under the Lecture Progress tab you can see which students have completed which parts of each Module.
### Student Details: Logic

<table>
<thead>
<tr>
<th>Introduction</th>
<th>Basic Logic Gates</th>
<th>Logic gates to truth tables</th>
<th>Truth tables to logic gates</th>
<th>Karnaugh Maps</th>
<th>Logic blocks and busses</th>
<th>MUXES</th>
<th>SRAM example</th>
</tr>
</thead>
<tbody>
<tr>
<td>in all-nah</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>der</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hoff</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>la</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>sarr</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>is</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>e</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>ring</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

### Digital Logic Design

*Introduction to Computer Architecture*

David Black-Schaffer

---

v. 3.21 December 2016 Page 38 © 2016 David Black-Schaffer/ScalableLearning
Using ScalableLearning In-Class

To use ScalableLearning in-class, you first select the items from the Module you wish to review in-class while reviewing the Students' Progress. Then in-class, ScalableLearning will help you review that material by displaying it on a projector along with the quiz results or the students' questions. This helps you bring the material you have selected from the online preparation into the classroom with minimal effort.

Reviewing Students' Online Performance

Before coming to class you should spend some time reviewing how students did on the online quizzes and answering any questions they have asked online, as discussed earlier in the manual. You should choose the online quizzes and questions you would like to review in-class and reply to students' questions. Remember that the students have already seen these quizzes at home, so be careful to not spend too much time repeating in-class. In general, in-class time should be spent on active learning such as group problem solving and not listening to the teacher review the online material unless there are significant confusions or great student questions.

Choosing In-class Material

If you have In-class Videos in your Module, when you go to the In-Class mode you will have the option to select them to include in the classroom. Choose the quizzes and material you want to include, along with the online quizzes and student questions from the review. You can choose to include or exclude portions of the in-class videos by selecting the Notes you wish to be visible much as you would hide or show slides in a presentation.

Online quizzes are shown in green, online questions in black, in-class quizzes in orange, and slide notes in gray.

In-class Review: ISA 2

The ISA lies, but you can trust it

Quiz: What are all processors internally today, and why? Visible

ISA 2 Survey

Free Text Question: List one thing that could be improved about this lecture: Visible

Branch encoding

Quiz: How would a LULI instruction affect 32-bit constant load performance? Visible

Marker: Practice: Encoding branches & immediates

Branch offsets

Quiz: Which of these branches will jump forwards 4 instructions? Visible

Marker: Branch address calculation (example)

Marker: Practice: Branch offset

Using ScalableLearning In-Class

When you click the “Display for In-Class Review” button, ScalableLearning will switch to a full-screen display suitable for projecting in the classroom. From this display you can use the arrow keys or a remote presentation controller to control your presentation.
1. The full-screen view is designed to be projected in a classroom.
2. You can use a standard presentation remote control to control the screen, including the arrow keys to go between questions.
3. The display shows the estimated time as a countdown in the lower right hand corner.
4. You can switch to higher resolution by clicking on the “HD” button at the top.
5. You can start the video playing with the play button at the top and mute/unmute the audio. (Typically you will just advance through the questions in the video that you have marked during the progress review, but you can also play it if it is helpful in the classroom.)
6. Using the controls at the bottom you can go to the next/previous question and advance the video by +/- 5 seconds to get to the next slide.

You can use the menu at the bottom to navigate directly to different quizzes, questions, or notes in the module:

When you advance to a selected online quiz, the video will be shown along with a graph showing how students answered it online. This is helpful for discussing the question with the
class. You can use the +/- 5 sec buttons at the bottom to see other parts of the video as well.

Peer Instruction with ScalableLearning

When you get to a Peer Instruction question, you will see the four steps at the bottom of the video with the current one highlighted:

- **Introduction**: Teacher introduces the question
- **Self**: Students work on and choose an answer themselves
- **Group**: Students work in groups of 2 to choose an answer
- **Discussion**: The Teacher leads a discussion of the answers

When you advance to the Self or Group portions a timer will be displayed and students can use their mobile phones to vote for the correct answer, and type in their reason for that choice. If they enter a reason, it will be visible to them online when the review the in-class video at home.
### Class Projector

#### Self

**Display question and timer.**

- `Pi: Branch offset`
- Which of these will jump forward 4 instructions?
  - `beq R1, R1, 16`
  - `beq R1, R1, 12`
  - `beq R1, R1, 4`
  - `beq R1, R1, 3`
  - Can't tell: Conditional branches depend on the values in the registers

#### Group

**Display question and timer.**

- `Pi: Branch offset`
- Which of these will jump forward 4 instructions?
  - `beq R1, R1, 16`
  - `beq R1, R1, 12`
  - `beq R1, R1, 4`
  - `beq R1, R1, 3`
  - Can't tell: Conditional branches depend on the values in the registers

#### Discussion

**Display question and results.**

- `Pi: Branch offset`
- Which of these will jump forward 4 instructions?
  - `beq R1, R1, 16`
  - `beq R1, R1, 12`
  - `beq R1, R1, 4`
  - `beq R1, R1, 3`
  - Can't tell: Conditional branches depend on the values in the registers

### Students' Mobile Phones

- **Self**
  - Students vote individually.

- **Group**
  - Students vote in group.

- **Discussion**
  - Students see their choices.

### Reviewing Student Performance After Class

After class you can go into the Review mode and see how students answered the in-class questions just as you can for the online quizzes. Students can also go and review the in-class material again by re-watching the videos at home.
Viewing your Courses

- **Current Courses:** You can see a list of your current courses under the “My Courses” menu.

- **All Courses:** You can see all courses (including finished courses) by choosing “Show all courses” from the “Courses” menu. You can then choose to view all courses, your current courses, or finished courses, and search for courses.

- You can go directly to any course by choosing it here.

- **Deleting Courses:** You can delete a course by clicking on the trash can to the right of the course in the “All Courses” view and then clicking on the confirmation button.

- **New Courses:** You can create a new course by choosing “New Course” in the “Courses” menu.
Organizing Courses with Modules
You can use Modules to organize your course. Modules allow you to group multiple videos, surveys, and quizzes, and can all have the same due dates and visibility dates.

Modules can be thought of as complete lectures or units in your course. By dividing up your videos into short segments you give students an indication of their progress (each completed video gets a green checkmark) and make it easier for them to navigate the course material.

Example. Here you can see an example of a course with multiple Modules (Introduction, ISA 1, ISA 2, Lab 1, Arithmetic, Logic) and multiple items within the Logic Module (short videos, a survey, and links to extra material.) You can also see how the student has completed the first 5 video segments of the Module.

1. To create a new Module, click “Add Module” at the bottom of the course content list on the left.
2. You can then configure the module in the Details tab on the right:
3. To add items to the Module click “Add Content” in the Module Editor or at the bottom of the module in the content list, and choose what you would like to add:
a. Videos, quizzes, and surveys will show up in the module. Links will show up under Course Links.

b. **Videos**: Videos with interactive quiz questions
   i. **Video**: Online preparation
   ii. **In-class Video**: Interactive videos for in-class problems and voting.
   iii. **Distance Peer Videos**: Interactive videos for distance students

c. **Quiz**: A text-based graded quiz. (Right/wrong answers.)

d. **Survey**: A text-based un-graded survey. (No correct answers.)

e. **Link**: Links to other websites or online content.

4. You can re-order items in a Module by dragging on the arrows to the left of the items. You can delete items by clicking on the Trash Can and the confirming the deletion.

5. To move items between modules use Copy and Paste by right-clicking on the item.
   a. Select the item you want to move and choose “Copy” by right-clicking on the item. (Here the video “Hello World” is selected in the “New Module” module.)
b. Go to the module where you would like to paste the item, and choose “Paste Item” from the Content menu. (Note you can copy and paste whole Modules and individual items between courses.)
Adding Links to a Course

You can add links to Modules. Links can be used to point to external online resources for a course, such as a university LMS, course discussion forums, tools, etc.

Course Links

1. Create a course link by clicking “Add Content”.

2. Choose “Link” from the New Content types.

3. Edit the Course Link by clicking on the link in the course content list and editing the link Title and URL in the Details tab on the right.
Adding Teachers and TAs
Adding other Teachers and TAs to a course allows others to review student progress, edit the course content, and reply to student questions.

1. Go to the course by choosing it from the “Courses” menu.
2. Click on “Add Teacher/TA” from the Administration menu.

3. Click “Add Teacher” and enter the email address for the teacher and specify whether the teacher is to be added as a TA from the menu.

   A teacher or TA must have a teacher account on scalable-learning. To create a teacher account visit: http://www.scalable-learning.com/4/users/teacher

4. The teacher will receive an email inviting them to join the class. If they do not have a teacher account on ScalableLearning they will have to create one to join the class.
5. Once the teacher has been invited to join the course, he or she will see a Notifications list in ScalableLearning and will be able to choose to join the course from there.
Sharing Courses with Other Teachers
You can share a copy of your course content with other teachers.

1. Go to the course by choosing it from the “Courses” menu.
2. Choose the Module you wish to share by clicking on it in the Course Content list on the left and right-click to choose “Share”.
3. Select the items from the Module to share and enter the teacher’s email address.
4. When the teacher logs into ScalableLearning he or she will receive a notification that the material has been shared and can place a copy of it in his or her course.
Recording Videos

How you record a video depends a bit on what type of computer and program you are using.

- For the Mac we recommend:

<table>
<thead>
<tr>
<th>Program</th>
<th>Record Yourself</th>
<th>Auto scaling to 1280x720</th>
<th>Start/Stop Shortcut</th>
<th>Trimming Ends of Video</th>
<th>Auto Upload to YouTube</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime Player</td>
<td>(stop)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Free</td>
<td></td>
</tr>
<tr>
<td>ScreenFlow</td>
<td>(complex)</td>
<td>(complex)</td>
<td>Yes</td>
<td>(complex)</td>
<td>Yes</td>
<td>700SEK</td>
</tr>
<tr>
<td>Screen Record</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>35SEK</td>
</tr>
<tr>
<td>Screen Record Studio</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>105SEK</td>
</tr>
<tr>
<td>iScreen Recorder Pro</td>
<td>Yes</td>
<td>(soon?)</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>80SEK</td>
</tr>
<tr>
<td>U2Any Screen Recorder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>100SEK</td>
</tr>
<tr>
<td>Screeny</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>100SEK</td>
</tr>
<tr>
<td>Camtasia</td>
<td>(complex)</td>
<td>(complex)</td>
<td>Yes</td>
<td>(complex)</td>
<td>Yes</td>
<td>700SEK</td>
</tr>
<tr>
<td>Snagit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>260SEK</td>
</tr>
<tr>
<td>Screenium</td>
<td>Yes</td>
<td>(complex)</td>
<td>Yes</td>
<td>(complex)</td>
<td>Yes</td>
<td>280SEK</td>
</tr>
<tr>
<td>Screencast Maker</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*</td>
<td>*</td>
<td>35SEK</td>
</tr>
<tr>
<td>Adobe Presenter Video Express</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>14SEK per video</td>
</tr>
</tbody>
</table>

* Supports this indirectly by opening in QuickTime Player after recording.
  - Note that the programs that scale the screen by themselves will make the mouse pointer really small. You can make it larger with programs such as ScreenFlow and Camtasia, or with utilities such as Keymo ($5), PinPoint ($5). (The built-in MacOS X pointer enlargement does not get recorded.)

- For Windows we recommend:
  - Camtasia (170EUR, lots of features, record yourself as well)
  - Snagit (30EUR, simple screen recorder)
  - Adobe Presenter ($500, lots of features)
  - (There are lots of other free utilities, which we have not tried.)

- Most of these programs will easily upload your videos directly to YouTube for hosting.

Setting Up the Screen

1. When you record your video you don’t want to make it too large. Normally people have their computer screens set to full HD resolution (1920x1080). For recording videos you want to reduce this resolution to reduce the file sizes. Typically you want 1280x720 for widescreen (or 1024x768 for non-widescreen presentations if you don’t want the black on the sides).

2. On a Mac: Apple Menu → System Preferences → Displays

   ![System Preferences](image)
3. On Windows: Control Panel → Hardware and Sound → Display → Change Display Settings → Resolution

4. When you change the resolution to a lower one than what you usually use, everything will look larger and blurry. This will not be a problem because the video will record fewer pixels (the resolution is lower) and will look fine. When you are done recording set your screen back to the previous values.

Recording

5. To record, launch your presentation program and your screen recording program.
6. Tell your screen recorder to start recording.
   - This is typically done by choosing “New Screen Recording” or typing a special key combination.
○ Make sure that your microphone is recording well and close the door!
○ Once you have started recording, switch your presentation into full screen mode and record your presentation.
○ When you are done, stop the recording either by clicking on the stop button or using the special key combination.

Trimming

7. Once you have recorded your video, you need to trim off any starting or ending parts you don’t want in your video.
8. Trimming can be done on your own computer or in YouTube after you have uploaded the video.
   ○ In QuickTime Player you chose “Trim” from the Edit menu and drag the yellow handles. Drag them until any extra material at the start or end is removed and click Trim.

○ If you want to trim after you have uploaded your video, choose Edit ➔ Enhancements in the YouTube video manager:
o Then click on the trim scissors at the bottom and drag the handles at the left and right:

Once you have recorded your video we recommend you save a copy on your computer in case you want to edit it again or upload it to another service. (You can re-download it from YouTube, but it will have been recompressed.)
Uploading Videos to YouTube

Most video capture programs let you directly upload a video to a YouTube account. Otherwise you have to save the video to your local computer, log into YouTube, and drag the video into the YouTube upload window to upload it.

- In QuickTime Player choose File→Share→YouTube and use your YouTube account information:

- To upload a video manually, log into your YouTube account with your web browser and click on “Upload”

- Then drag the files to the upload icon to upload them:

- When you first upload a movie, YouTube will process it. This can take several minutes depending on the size of the movie. Until it is done being processed you cannot view or
edit the movie.

YouTube Videos Privacy: Unlisted or Public
When you upload YouTube videos they can be public (anyone can see them and find them by searching), private (only google accounts you allow can see them), or unlisted (anyone with the right URL can view them, but no one can find them via search). You should keep your videos either public or unlisted.

9. Go to the YouTube Video Manager

10. Click “Edit” on your video:

11. Set your desired privacy settings and save the changes:

Privacy settings ᵉ

Unlisted

Anyone with the link can view
More Information
You can read more about Flipped Classroom teaching and tips and tricks in the Introduction to Flipped Classroom Teaching available in the Help menu on ScalableLearning.

If you have any questions, comments, or feedback, please feel free to email me directly at david.black-schaffer@it.uu.se or join in the discussion with other teachers in the ScalableLearning teacher forum from the Help menu.